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和／或其他國家／地區的商標。

保固

本文件所含內容係以「現狀」提供，
未來版本若有變更，恕不另行通知。
此外，在相關法律所允許之最大範
圍內，Agilent 不承擔任何瑕疵責任
擔保與條件，不論其為明示或暗示
者，其中包括（但不限於） 適售性、
適合某特定用途以及不侵害他人權
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提供、使用或運用本文件或其中所
含的任何內容，所衍生之任何損害
或所失利益或錯誤，皆不負擔責任。
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材料保固條款簽訂其他書面協議，
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合約條款為準。

技術授權 

此文件中所述的硬體及／或軟體係
依授權提供，且僅可以依據此類授
權之條款予以使用或複製。

限制權利聲明

美國政府限制權利。授予聯邦政府之軟
體及技術資料僅包含為一般使用者提供
的自訂權利。Agilent 依照 FAR 12.211
（「技術資料」）及 12.212 （「電腦軟
體」）、國防部 DFARS 252.227-7015（「技
術資料 -  商業條款」） 以及 D FA R S
227.7202-3 （「商業電腦軟體」或「電腦
軟體說明文件」中的權利）提供此軟體
與技術資料之自訂商業授權。

安全聲明

注意

注意標示代表發生危險狀況。如
果沒有正確執行或安裝，這個標
示提醒您注意操作程序、作法或
警告您這可能會導致產品損毀
或重要資料遺失。除非已經完全
了解並符合所指定的狀況，否則
請不要在出現注意標示的狀態
下繼續進行。

警告

「警告」標示代表發生危險狀
況。如果沒有正確執行或安裝，
這個警告會讓您注意操作程序、
作法，或告訴您這樣的狀況可能
會導致人員受傷或死亡。除非已
經完全了解並符合所指定的狀
況，否則請不要在出現「警告」
標示的狀態下繼續進行。



安全符號

下列出現在儀器上與文件中的符號，表示在維持儀器的安全操作時
所必須採取的預防措施。

直流電 (DC)

交流電 (AC)

直流電與交流電

注意，危險（請參考本手冊以獲得特定的「警告」或
「注意」資訊）
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安全考量

使用本儀器之前，請先閱讀下列資訊。本手冊中的描述和說明適
用於 Agilent 模組式產品系列中的所有儀器。若要瞭解更多相關安
全注意事項，請參閱您的模組式產品的相應使用者指南。

警告 • 如果裝置毀損，請勿繼續使用。在您使用裝置前，請先檢查
外殼，尋找是否有裂痕或遺失塑膠零件。

• 請勿在有爆炸性氣體、蒸氣或潮濕的環境下操作裝置。

• 在建立任何連接之前，請先檢查裝置上的所有標示。

• 在連接到 I/O 端子之前，請先關閉裝置與應用系統的電源。

• 使用裝置時，請僅使用指定的更換零件。

• 請勿在外蓋被移除或鬆脫的情況下操作裝置。

• 在進行自我測試程序之前，請勿連接任何纜線與終端台。

• 僅使用製造商提供的電源配接器，避免出現任何非預期的危
險狀況。

注意 • 靜電放電 (ESD) 會導致設備和配件中的元件損毀。纜線或電
線應先連接至插入式接頭並以纜線外殼包覆後，再插入輸出
接頭，以避免發生 ESD。

• 如果未依製造商指定的方式使用裝置，可能會減損裝置保護
功能。

• 請務必使用乾布來清潔裝置。請勿使用酒精或其他任何揮發
性液體來清潔裝置。

• 不可擋住裝置的通風孔。



法規標誌

CE 標誌是「歐洲共同體」的註冊商
標。貼有此 CE 標誌表示產品符合所
有相關的 「歐盟法規指令」。

C-tick 標誌是澳洲 Spectrum
Management Agency 的註冊商標。貼
有此標誌表示產品符合 1992 年所
制定之「無線通訊法」條款下的
「澳洲 EMC 架構」法規。

ICES/NMB-001 代表此 ISM 裝置符
合 Canadian ICES-001 的規定。
Cet appareil ISM est confomre a la norme
NMB-001 du Canada.

本儀器符合 WEEE 指令 (2002/96/EC)
標示需求。此產品黏貼標籤表示您
不得將本電機或電子產品隨同家庭
廢棄物丟棄。

CSA 標誌是 「加拿大標準協會」的
註冊商標。

此符號表示在正常使用時不會有危
險或有毒物質發生洩漏或變質的預
期時間長度。產品的預期使用壽命
為四十年。
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廢電機電子設備 (WEEE) 指令 2002/96/EC

本儀器符合 WEEE 指令 (2002/96/EC) 標示需求。此產品黏貼標籤表
示您不得將本電機或電子產品隨同家庭廢棄物丟棄。

產品類別：

根據 WEEE 指令附錄 1 中所參照之設備類型，本儀器分類為「監控
儀器」產品。

產品的黏貼標籤如下所示。

請勿隨同家庭廢棄物丟棄。

若要退回此廢棄儀器，請連絡最近的 Agilent Service Centre，或造訪

www.agilent.com/environment/product

以取得詳細資訊。
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符合標準聲明 (DoC)

Agilent 網站上提供此儀器的符合標準聲明 (DoC)。您可以在下列網
址依產品型號或說明搜尋 DoC。

http://regulations.corporate.agilent.com/DoC/search.htm

附註 如果您無法找到對應的 DoC，請聯絡您本地的 Agilent 代表。
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Agilent USB 模組式產品和系統
USB 模組式產品和系統
USB 模組式產品和系統

USB 模組式產品和系統包含各種測試和測量儀器，提供您建立可隨
測試需求變化而擴充及進展之解決方案所需的選擇與靈活度。

圖 1 USB 模組式產品和系統系列

模組式產品的標準功能摘要

• 配有高速 USB 2.0 連接，最高處理速度可達 480 MB/ 秒

• 需要 PC 才能運作

• 隨附 Agilent Measurement Manager 軟體，可立即開始測量

• 支援 Agilent Open 程式並與各種應用程式開發環境 (ADE) 相容

• 搭配 Agilent U2781A USB 模組式產品機箱使用時，可做為獨立
儀器或組合模組操作 ( 最多可容納六個獨立模組 )
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Agilent USB 模組式產品和系統
USB 模組式產品和系統
標準購買套件項目

如需每一種模組式產品的標準購買套件項目清單，請參閱您模組式
產品的使用指南。確認標準購買套件項目。如果有任何項目缺少或
損毀，請聯絡您當地的 Agilent 營業處。

檢查與維護

初始檢查

當您收到 USB 模組式產品時，請檢查該裝置是否有任何可能在運
送期間發生的明顯損壞。如果發現任何損壞之處，請立即聯絡您當
地的 Agilent 營業處。請保留原始的包裝，以備日後必須將購買的
USB 模組式產品送回 Agilent 時使用。

一般維護

1 關閉您的裝置，然後從裝置拔除電源線與 I/O 纜線。

2 從緩衝板外殼取出您的裝置。

3 拂去裝置上可能積存的灰塵。

4 使用乾布擦拭裝置，然後將緩衝器外殼安裝回正確位置。

附註 模組式產品手冊未涵蓋的任何維修工作，僅可由合格的專業人員
進行。
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安裝和設定
安裝和設定

依照以下流程圖所顯示的逐步指示開始準備及安裝 USB 模組式
產品。

圖 2 安裝和設定流程圖

附註 如果要將 USB 模組式產品與 Agilent VEE Pro、NI LabVIEW 或 Microsoft®

Visual Studio® 軟體搭配使用，您需要安裝 IVI-COM 驅動程式。

「A. 檢查您的系統」

「B. 安裝 Agilent IO Libraries Suite」

「C. 安裝模組驅動程式」

「D. 安裝 Agilent Measurement Manager」

「E. 將模組連接到 PC」

「F. 確認模組連接」

「G. 啟動 Agilent Measurement Manager」
Agilent USB 模組式產品和系統快速入門指南 13



Agilent USB 模組式產品和系統
A. 檢查您的系統
A. 檢查您的系統

在進行任何安裝和設定之前，請確定您的 PC 符合下列最低系統需求。

要求 Windows XP 作業系統 Windows Vista 作業系統 Windows 7 作業系統

作業系統 Windows XP Service Pack 3 (或
更新版本 )[1]

[1] 受支援的 Windows XP 版本 — Home 或 Professional

Windows Vista (32 位元 )
Service Pack 1 和 2[2]

[2] 受支援的 Windows Vista (32 位元 ) 版本 — Home Basic、Home Premium、Business 或 Ultimate

Windows 7 (32 位元和 
64 位元 )[3][4]

[3] 受支援的 Windows 7 (32 位元和 64 位元 ) 版本 — Home Basic、Home Premium、Professional、Enterprise 或 Ultimate

[4] Windows 7 64 位元支援的 Agilent Measurement Manager 是一個 32 位元應用程式，在 WOW64 (Windows 64 位元上
的 Windows) 模擬器上執行。

處理器速度 需要 600 MHz 或更快速度的
處理器，建議使用 800 MHz

1 GHz 32 位元 (x86) 3 GHz 32 位元 (x86)

記憶體 最小 256 MB（建議使用 1 GB
或更大）

最小 1 GB 最小 2 GB

硬碟空間 最小 1.5 GB 最小 1.5 GB 最小 1.5 GB

視訊 Super VGA (800 × 600) 256 色
或以上

支援 DirectX 9 圖形，建議使
用 128 MB 圖形記憶體[5]

[5]  Windows Vista 和 Windows 7 支援 Super VGA 圖形。

支援 DirectX 9 圖形，建議使
用 128 MB 圖形記憶體 [5]

CD-ROM 光碟機或 
DVD-ROM 光碟機[6]

[6] 根據產品隨附的媒體的類型確定需要使用 CD-ROM 光碟機或是 DVD-ROM 光碟機。

必需 必需 必需

瀏覽器 Microsoft Internet Explorer 5.01
或更新版本

Microsoft Internet Explorer 7
或更新版本

Microsoft Internet Explorer 7
或更新版本
14 Agilent USB 模組式產品和系統快速入門指南



Agilent USB 模組式產品和系統
A. 檢查您的系統
軟體需求 提供方式

IO Libraries Suite 15.5 由  Agilent Automation-Ready CD-ROM 提供

Agilent T&M Toolkit Runtime 
2.1 版

在 Agilent Measurement Manager 軟體應用程式安裝程式中隨附

Agilent T&M Toolkit Redistributable 
Package 2.1 修補程式

在 Agilent Measurement Manager 軟體應用程式安裝程式中隨附

Microsoft .NET Framework 2.0 版 在 Agilent Measurement Manager 軟體應用程式安裝程式中隨附
Agilent USB 模組式產品和系統快速入門指南 15



Agilent USB 模組式產品和系統
B. 安裝 Agilent IO Libraries Suite
B. 安裝 Agilent IO Libraries Suite

如果您的 PC 上已安裝 Agilent IO Libraries Suite 15.5 或更高版本，
則您可以繼續執行第 23 頁的「C. 安裝模組驅動程式」。如果尚未安
裝 IO Libraries Suite，請先遵循此處的步驟進行安裝。

1 確認您的 PC 符合最低系統需求 （請參閱第 14 頁的 「A. 檢查
您的系統」 ）。關閉 PC 上的其他所有應用程式，並且準備好
Agilent Automation-Ready CD-ROM。

2 如果您要從舊版的 IO Libraries Suite 升級為最新版的 IO
Libraries Suite，您必須先移除下列儀器和介面，才能將您的軟
體升級。

您必須執行此步驟，才能讓這些裝置取得正確的驅動程式來使用
Agilent IO Libraries Suite。

i 拔除所有 USB 儀器與您 PC 的連線。

ii 拔除所有 Agilent 82357 USB/GPIB 介面轉換器與您 PC 的
連線。

iii 拔除所有 Agilent E8491 IEEE 1394 PC Link to VXI 介面與
您 PC 的連線。

3 關閉您 PC 上的其他所有應用程式。

附註 您必須擁有管理員權限，才能安裝 IO Libraries Suite Connection
Expert。

附註 • 如果您在安裝 IO Libraries Suite 的同時於電腦上安裝 PCI 卡，則可能
會發生衝突。必須先關閉 PCI 卡的「找到新硬體」對話方塊，才
能繼續進行安裝。否 IO Libraries Suite 安裝將停止，直到 PCI 卡安裝
完成為止。

• 如果您已安裝 NI 軟體 ( 例如 NI MAX 等 )，在安裝 IO Libraries Suite
之前必須先停止所有 NI 服務。
16 Agilent USB 模組式產品和系統快速入門指南



Agilent USB 模組式產品和系統
B. 安裝 Agilent IO Libraries Suite
4 將內含 IO Libraries Suite 的 Agilent Automation-Ready
CD-ROM 放入 PC 的 CD-ROM 光碟機中。等待幾秒鐘，直到出
現自動執行視窗。

如果沒有自動出現自動執行視窗，

• 按一下 Start > Run...

• 輸入 <磁碟機 >:autorun\auto.exe（其中 <磁碟機 > 是
您 CD-ROM 光碟機的代號）。

5 安裝啟動視窗出現時，按一次 「Click here to install now」按
鈕，然後等待 「InstallShield Wizard」出現。

附註 每一項 IO Libraries Suite 安裝都是 「完整安裝」

在舊版 IO Libraries Suite 中，會提供安裝完整版或 Runtime 版 IO
Libraries 的選項。從 IO Libraries Suite 14.0 開始，安裝程序針對所有
使用者均提供完整安裝 （也就是不再提供 Runtime 安裝選項）。也
就是說，現在每一項安裝都包括 IO Libraries Suite 軟體的開發元件，
可讓您開發自己的 I/O 程式。如果您希望將安裝軟體的大小降至最
低，請選取「Custom」安裝；出現「Select Features」對話方塊時，
請不要選取手冊和範例程式。
Agilent USB 模組式產品和系統快速入門指南 17



Agilent USB 模組式產品和系統
B. 安裝 Agilent IO Libraries Suite
6 如果您的 PC 尚未安裝 IVI 共用元件和 IVI VISA COM 標準元
件，IO Libraries Suite 會將它們安裝到預設位置。

7 當 「InstallShield Wizard」出現時，請按一下 Next >，開始進
行 IO Libraries Suite 軟體安裝。

8 閱讀授權合約。如果您接受條款，請按一下標記為 「I accept
the terms of the license agreement」的選項按鈕，然後按一下
「Next >」繼續。

9 當「InstallShield Wizard Setup Type」對話方塊出現時（如圖
所示），選取 Typical 或 Custom，然後按一下 Next >。

附註 您也可以選擇觀看兩分鐘的短片，了解使用 IO Libraries Suite 15 安
裝、建置和設定介面與儀器多麼簡單。

附註 IVI 共用元件和 IVI VISA COM 標準元件會安裝到預設資料夾中。不過，
如果您需要將 IVI 元件安裝到專屬位置，請參閱 Agilent IO Libraries
Suite 連接指南中的 「IVI 共用元件的自訂安裝」。
18 Agilent USB 模組式產品和系統快速入門指南



Agilent USB 模組式產品和系統
B. 安裝 Agilent IO Libraries Suite
「Typical」安裝會將適用於您配置的建議功能安裝在您 PC 的
標準位置上。在 「Typical」安裝中，如果此 PC 已安裝其他廠
商的 VISA 軟體，則 Agilent VISA 會安裝為次要 VISA。如果在
此 PC 上找不到其他廠商的 VISA 軟體，則 Agilent VISA 會安裝
為主要 VISA （另請參閱 Agilent IO Libraries Suite 連接指南
中的 「以並存模式使用 Agilent VISA」）。

10 如果您選擇「Custom」安裝，且 您的 PC 上並未安裝其他廠商
的 VISA 實作，則將出現下列對話方塊，詢問您是否要將 Agilent
VISA 安裝為主要 VISA。

如果您已安裝其他廠商的 VISA，將會出現類似的對話方塊，但
是核取方塊並不會選取，表示預設是將 Agilent VISA 安裝為次
要 VISA。

如需此主題的詳細資料，請參閱 Agilent IO Libraries Suite 連
接指南中的 「以並存模式使用 Agilent VISA」。

附註 • 如果您接受 「Typical Installation」，請按一下 Next > 並繼續進行
步驟 13。

• 如果您選擇「Custom Installation」選項按鈕，請按一下 Next > 並
繼續進行下面的步驟 10。
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11 如果您選擇「Custom」安裝，則下一個對話方塊會顯示下列各
項的位置：

• IO Libraries Suite 目的地資料夾

• Agilent VISA 目的地資料夾

• IVI 元件目的地資料夾

VISA 和 IVI 目的地會顯示為灰色。這兩個位置僅做為參考資
訊提供。若要進行變更，您必須依照中 Agilent IO Libraries
Suite 連接指南 「自訂安裝 IVI 共用元件」的指示進行。

12 如果您選擇「Custom」安裝，現在將看見 「Select Features」
對話方塊。

i 按一下清單中的任何功能，即可查看功能說明以及所選取功
能集的空間需求。如果您計劃要使用 IO Libraries Suite 來執
行程式式，則建議您安裝手冊和範例程式。不過，您可以省
略它們以節省空間。

ii 請選取所要安裝之各項功能的核取方塊。清除要省略之各項
功能的核取方塊。選取功能完成後，按一下 Next >。

13「Start Copying Files」對話方塊便會出現；按一下 Install 開始
複製檔案。

如果 PC 上之前未安裝 Microsoft .NET Framework 2.0 版本，
IO Libraries Suite 將會安裝該版本；此程序最多需要十分鐘。
Microsoft .NET Framework 為 IO Libraries Suite 公用程式，以
及 .NET 程式設計工具和許多其他應用程式提供了必要的基礎
架構。即使您移除後重新安裝，或是升級 IO Libraries Suite，
都只需要安裝一次 .NET Framework。
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14 檔案複製完成後，會出現一個對話方塊，要求您重新啟動 PC。
這種情況只有在您採用特定 I/O 硬體組態時才會發生。如果您選
擇此時不要重新開機，則應在執行 Connection Expert 之前重
新開機。

15 當 「InstallShield Wizard Completed」對話方塊出現時，表示
IO Libraries Suite 已成功安裝。

i 按一下 Finish 關閉此視窗。

ii 或按一下其中一個產品／解決方案連結，取得其他 Agilent 解
決方案的資訊。

16 按一下右下方「Windows 通知」區域中的 IO 控制項圖示 ( )，
即可執行 IO Libraries Suite。

17 如果您要搭配 IO Libraries Suite 一併安裝其他儀器、介面或軟
體套件 （例如 Agilent VEE），則可能有另一張包含附加軟體的
CD （驅動程式、範例程式等）。如果您要安裝此附加軟體，

• 將 CD 插入 PC 上的 CD-ROM 光碟機。

• 依照 CD 內附或是硬體或軟體產品隨附的指示進行。

18 將您可能在步驟 2 中斷連線的任何 USB 儀器或 E8491 IEEE-1394
FireWire 重新連接到 VXI 介面。安裝所有新硬體。

19 如果 Connection Expert 已在執行，請按一下 Refresh All 找出您
剛安裝或重新連接的任何硬體。

20 如果 Connection Expert 還未執行，請立即執行以確認您的 I/O
組態：在 「Windows Notification」區域中，按一下 IO 圖示
( )，然後按一下 Agilent Connection Expert。

i 在 「Explorer」窗格中尋找您的介面和儀器。按一下介面和
儀器，即可查看其屬性（顯示於右側窗格中）。查看其狀態，
同樣顯示於右側窗格中：如果與介面或儀器的通訊已成功建
立，則會處於 「Verified」狀態，並且以綠色勾號表示。
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ii 在您要設定之介面或儀器的屬性窗格中按一下 Change Properties...，
變更預設 I/O 組態（如有需要）。

iii 如果您要手動測試連線，請選取您的儀器，然後按一下滑鼠
右鍵並選擇 Send Commands To This Instrument。

如果情況允許，應盡量使用最新版的 Agilent IO Libraries Suite。
此版本支援最新的介面和作業系統，並且擁有最先進的功能。如需
IO Libraries Suite 的詳細資訊，請造訪
www.agilent.com/find/iosuite 。

附註 如果您打算使用 Agilent 488 API 設計 GPIB 儀器，或是透過 Agilent 介
面硬體 （例如 GPIB 卡）執行與 NI-488.2 相容的程式，則可能需要
啟用 Agilent 488 程式庫。若要這樣做，請按一下 Tools > Agilent 488...，
然後選取標記為「Enable Agilent GPIB cards for 488 programs」的核取
方塊。

附註 如果在安裝 IO Libraries Suite 時發生問題，請參閱 Agilent IO Libraries
Suite 連接指南中的 「安裝疑難排解」一節。

停用 UAC 的 Vista 安裝

如果在使用 Windows Vista 作業系統的系統上安裝 IO Libraries Suite
時發生問題，可能是因為啟用了 「使用者帳戶控制 (UAC)」。通常
您會收到錯誤訊息，表示目錄名稱無效。安裝 IO Libraries Suite 之前
必須先停用 UAC。
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C. 安裝模組驅動程式

1 確認您的 PC 符合最低系統需求 （請參閱第 14 頁的 「A. 檢查
您的系統」）。關閉 PC 上的所有其他應用程式，準備好 Agilent
USB 模組式產品和系統產品參考 DVD-ROM。

2 將 Agilent USB 模組式產品和系統產品參考 DVD-ROM 插入 PC
上的 DVD-ROM 光碟機。等待幾秒鐘，直到出現自動執行視窗。

如果沒有自動出現自動執行視窗，

• 按一下 Start > Run...

• 鍵入 <光碟機 >:\\Autorun.exe，其中 <光碟機 > 是您的
DVD-ROM 光碟機的代號。

3 安裝啟動視窗出現時，按一次「Hardware Driver」按鈕，然後
等待「InstallShield Wizard」出現。

附註 • 請先確定您已拔除 PC 與 USB 模組式產品的連線，再安裝驅動
程式。

• 請先確定您已安裝 IO Libraries Suite 15.5 版或更新版本，然後再繼
續進行下列步驟。如需 IO Libraries Suite 安裝程序的詳細資訊，請
參閱第 16 頁的 「B. 安裝 Agilent IO Libraries Suite」。
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4 當 「InstallShield Wizard」出現時，請按一下 Next >，開始安
裝模組驅動程式。

5 閱讀授權合約。如果您接受條款，請按一下標記為 「I accept
the terms of the license agreement」的選項按鈕，然後按一下
Next > 繼續。

6 詳細閱讀 Readme 資訊。確定已從 PC 拔除所有 USB 模組式產
品裝置。按一下 Next > 繼續執行。

7 當「InstallShield Wizard Setup Type」對話方塊出現時（如圖
所示），選取 Typical 或 Custom，然後按一下 Next >。

「Typical」安裝會將適用於您配置的建議功能安裝在您 PC 的
標準位置上。

8 如果您選擇 「Custom」安裝，現在將看見 「Custom Setup」
對話方塊。

i 按一下清單中的任何功能，即可查看功能說明以及所選取功能
集的空間需求。

ii 選取 「This feature will not be available」選項，清除要省
略的各項功能。選取功能完成後，按一下 Next >。

附註 • 如果您接受「Typical Installation」，請按一下 Next 並繼續進行步
驟 9。

• 如果您選擇 「Custom Installation」選項按鈕，請按一下 Next 並
繼續進行下面的步驟 8。
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9 「Ready to Install the Program」對話方塊隨即出現；按一下
Install 開始複製檔案。

10 當 「InstallShield Wizard Completed」對話方塊出現，表示模
組驅動程式已順利安裝時，請按一下 Finish 關閉視窗。
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D. 安裝 Agilent Measurement Manager

1 如果您已在第 23 頁的「C. 安裝模組驅動程式」執行模組驅動程
式安裝，且 Agilent Modular Products Installation Menu 仍為開
啟狀態，則可繼續進行步驟 4。否則，請繼續執行下一步。

2 確認您的 PC 符合最低系統需求 ( 請參閱第 14 頁的「A. 檢查您
的系統」。) 關閉 PC 上的所有其他應用程式，準備好 Agilent
USB 模組式產品和系統產品參考 DVD-ROM。

3 將 Agilent USB 模組式產品和系統產品參考 DVD-ROM 插入 PC
上的 DVD-ROM 光碟機。等待幾秒鐘，直到出現自動執行視窗。

如果沒有自動出現自動執行視窗，

• 按一下 Start > Run...

• 輸入 < 磁碟機 >:\Autorun.exe，其中 < 磁碟機 > 是您的
DVD-ROM 光碟機代號。

4 安裝啟動視窗出現時，按一次「Measurement Manager」按鈕，然
後等待「InstallShield Wizard」出現。

附註 請先確定您已安裝 IO Libraries Suite 15.5 版或更新版本，然後再繼續
進行下列步驟。如需 IO Libraries Suite 安裝程序的詳細資訊，請參閱
第 16 頁的 「B. 安裝 Agilent IO Libraries Suite」。
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5 如果您沒有安裝任一種必備軟體，「InstallShield Wizard Software
Prerequisite」對話方塊便會出現。按一下 OK，開始安裝所列之
缺少的必備軟體。

依照畫面上的指示安裝所列之缺少的必備軟體。在上述安裝完
成之後，便會繼續進行正常的 Measurement Manager 軟體安
裝程序。

6 當 「InstallShield Wizard」出現時，請按一下 Next >，開始安
裝 Measurement Manager。

7 閱讀授權合約。如果您接受條款，請按一下標記為 「I accept
the terms of the license agreement」的選項按鈕，然後按一下
「Next >」繼續。

8 填寫 「Customer Information Form」，然後按一下 Next。

9 按一下 Next，將軟體安裝至指定的資料夾，或按一下 Change，
將其安裝至其他資料夾。

10「Ready to Install the Program」對話方塊隨即出現；按一下
Install 開始複製檔案。

11 當「InstallShield Wizard Completed」對話方塊出現，表示模
組驅動程式已順利安裝時，請按一下 Finish 關閉視窗。安裝程式
將會在桌面上建立此軟體的捷徑。

附註 從 PC 拔除所有模組式產品，再繼續進行。

附註 授權資料使用

使用授權資料即表示您同意授權條款。如果您不同意上述的所有條
款，請將任何尚未開啟的授權資料退回，以獲得全額退款。如果該
授權資料是隨附在其他產品中或已預先載入至該產品，則您可以將
尚未使用的完整產品退回，以獲得全額退款。
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E. 將模組連接到 PC

1 完成安裝所有軟體和驅動程式之後，請將電源線連接到 AC/DC
電源配接器。AC/DC 電源配接器的電源需求為 100 至 240 VAC、
50/60 Hz，輸出電壓為 +12 VDC。

2 將 AC/DC 電源配接器的 DC 輸出插頭插入 模組式產品後端面板
上的電源插孔。

3 使用隨附的 USB 纜線，將 USB 模組式產品連接到您 PC 上的任
何 USB 連接埠。

4 您的 PC 會自動偵測已連接之裝置，並且會出現 「Found New
Hardware Wizard」視窗。選取 「Yes, this time only」選項按
鈕，然後按一下 「Next」繼續執行。

5 選取「Install the software automatically (Recommended)」，然
後按一下 Next。

6 在 「Hardware Installation」視窗中會出現警告訊息。

請仔細閱讀警告，然後按一下 Continue Anyway 繼續安裝模組式
產品。

附註 • 請先確定已安裝  Measurement Manager，再繼續進行下列步驟。
如需 Measurement Manager 安裝程序的詳細資訊，請參閱第 26 頁
的 「D. 安裝 Agilent Measurement Manager」。

• 下圖僅供參考，在 PC 上顯示的內容可能根據您 PC 的作業系統和
連接的模組式產品類型而有所不同。
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7 當「Found New Hardware Wizard Completed」對話方塊出現，
表示裝置軟體已順利安裝時，請按一下 Finish 關閉視窗。

8 「Assign USB device alias」視窗會出現。每次插入模組式產品
時，此對話方塊就會出現。如果要停用這個對話方塊，請在
「Show this dialog」面板中選取「Never show this dialog」選
項，然後按一下 「OK」。

附註 如果您不希望以後收到類似的警告訊息，請依照下列指示執行：

1 移至 開始 > 控制台，然後按兩下系統圖示。

2 選擇硬體標籤，然後在 「驅動程式」面板上按一下啟動程式簽
署。此時會出現 「Driver Signing Options」對話方塊。

3 選取 「Ignore」選項按鈕，即可停用警告訊息。
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9 針對 U2300A 系列、U2500A 系列、U2600A 系列和 U2781A 以
外的模組，系統會在已連接的模組上執行韌體版本檢查。

i 如果模組韌體版本與 PC 上安裝的版本相同，則不會下載韌
體。現在您可使用模組式產品。

ii 如果模組韌體版本與 PC 上安裝的版本不同，則會出現下列訊
息方塊。依據連接至 PC 的模組而定，訊息方塊中顯示的型號
和韌體版本可能有所不同。

iii 按一下 Yes 開始下載韌體。以下訊息方塊將會出現，指出正
在下載。依據連接至 PC 的模組而定，訊息方塊中顯示的型號
可能有所不同。

10 一旦完成韌體下載和升級，您的模組式產品便可以開始使用。

注意 在完成韌體下載之前，不要拔除 USB 和電源連線。中斷韌體下載
程序可能導致裝置錯誤。
30 Agilent USB 模組式產品和系統快速入門指南



Agilent USB 模組式產品和系統
F. 確認模組連接
F. 確認模組連接

Connection Expert 是 IO Libraries Suite 的一個公用程式。
Connection Expert 可配置已連接的儀器，並支援通訊功能。它能
夠自動偵測任何插入 PC 中的模組式產品。

1 為 PC 和已安裝的模組式產品接通電源。

2 如果 Connection Expert 已在執行，請按一下 Refresh All 找出您
安裝或重新連接的任何硬體。

3 如果 Connection Expert 還未執行，請立即執行以確認您的
I/O 組態：在「Windows Notification」區域中，按一下 IO 圖
示 ( )，然後按一下 Agilent Connection Expert。

4 出現主畫面時，您將在此 PC 窗格（亦稱為「Explorer」窗格」）
的 Instrument I/O 中看見系統連接圖。

附註 下圖僅供參考，在 PC 上顯示的內容可能根據您 PC 的作業系統和連
接的 USB 模組式產品類型而有所不同。
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5 偵測到的模組式產品將在「Explorer」窗格的 Instrument IO 上
顯示。

當您在 「Explorer」窗格中選取特殊儀器時，將在右側的
「Properties」窗格中看見儀器的參數，例如產品型號、序號、
VISA 位址、GPIB 位址及韌體修訂版本等。

頂端的綠色核取標記圖示，表示已自動執行接聽程式檢查和識別
(*IDN) 查詢。
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6 我們將使用 Interactive IO 迅速確認與儀器的連線。Interactive
IO 是軟體公用程式，可讓您透過傳送命令至儀器及查看儀器的回
應，與儀器進行互動。

若要在 Connection Expert 內啟動 Interactive IO，請從
Connection Expert 功能表列按一下 Tools > Interactive IO，或是
在 「Explorer」窗格中以滑鼠右鍵按一下模組式產品。內容功
能表隨即出現。請選取 Send Commands To This Instrument。

7 此時會出現「Interactive IO」對話方塊。按一下 Send & Read，
傳送 *IDN? 預設命令。在 「Instrument Session History」面
板中應該會出現儀器回應訊息。

8 如果 Connection Expert 能夠順利與您的模組式產品進行通訊，
就表示已正確安裝儀器。
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G. 啟動 Agilent Measurement Manager

1 按兩下桌面上的 Measurement Manager 軟體圖示，或移至 Start >
All Programs > Agilent > Modular Products > Agilent Measurement
Manager，以啟動軟體。

2 Measurement Manager 歡迎畫面將會出現。

3 此時會出現 「Select USB Device」對話方塊，顯示已連接的模
組式產品。若要啟動應用程式，請選取模組式產品並按一下 OK
建立連線。依據連接至 PC 的模組而定，「Available USB
Devices」窗格中顯示的型號可能有所不同。

附註 IO Control 會在您啟動 PC 時自動啟動

若啟動 Measurement Manager 時並未執行 IO Control，將會導致無法
與任何連接至 PC 的 USB 模組式產品進行通訊。若要執行 IO Control，
請移至開始 > 程式集 > IO Libraries Suite > Utilities > IO Control。

附註 下圖僅供參考，在 PC 上顯示的內容可能根據您 PC 的作業系統和連
接的 模組式產品類型而有所不同。
34 Agilent USB 模組式產品和系統快速入門指南



Agilent USB 模組式產品和系統
G. 啟動 Agilent Measurement Manager
4 Measurement Manager 將根據選取的 USB 模組式產品啟動適當
的測量應用程式。如需有關您模組式產品應用程式軟體的詳細
資訊，請參閱 Agilent Measurement Manager Help File。
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USB 模組式產品機箱

Agilent U2781A USB 模組式產品機箱是可攜式機箱，最多能夠容
納六個 USB 模組式裝置。它配備了 USB 隨插即用連接，符合
USBTMC-USB488.2 標準[1]，因此能與 Measurement Manager 軟
體緊密搭配。 

購買 U2781A 機箱可讓您透過星型觸發匯流排，在模組之間加入同
步處理的能力。若要瞭解有關 U2781A 機箱的更多資料，請參閱
Agilent U2781A USB 模組式產品機箱使用者指南。

圖 3 已連接到 PC 的 U2781A 機箱

機箱安裝

L 型掛載套件將安裝在模組上。以下指示說明將 L 型掛載套件和您
的模組安裝到 U2781A 機箱的簡易程序。

1 拆開 L 型掛載套件的包裝。

2 從緩衝板外殼取出模組。

3 使用飛利浦十字螺絲起子，將 L 型掛載套件固定至模組。

4 將模組插入 U2781A 機箱中，並使 55 插腳的背板接頭位於模組
底部。若要瞭解更多資訊，請參閱第 37 頁的 「55 插腳背板接
頭插腳設定」。

5 插入模組後，鎖緊 L 型掛載套件的螺絲，以確保機箱連接穩固。

[1] 僅與 Microsoft Windows 作業系統相容。
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USB 模組式產品機箱
55 插腳背板接頭插腳設定

當您的模組是插入 U2781A 機箱時，會採用 55- 插腳背板接頭。請
參閱表 1 中的 SSI 接頭插腳描述。

圖 4 55 插腳背板接頭插腳設定

GND GND GND GND GND GND GND GND GND GND GND F

NC NC NC NC NC NC NC NC VBUS GND USB_D- E

GND TRIG3 GND TRIG2 GND TRIG1 GND TRIG0 GND GND USB_D+ D

TRIG4 GND TRIG5 GND TRIG6 GND TRIG7 GND +12 V +12 V GND C

nBPUB CLK10M GND STAR_TRIG GA2 GA1 GA0 NC +12 V +12 V +12 V B

NC NC NC NC NC NC NC NC +12 V +12 V +12 V A

11 10 9 8 7 6 5 4 3 2 1

表 1 SSI 接頭插腳描述

SSI 定時信號 功能

GND 接地

NC 未連接

VBUS USB 匯流排電源感測輸入

USB_D+、USB_D- USB 差分對

TRIG0 ~ TRIG7 觸發匯流排

+12 V +12 V 電源，具 4 A 電流

nBPUB USB 背板輸入偵測

CLK10M 10 MHz 時脈來源

STAR_TRIG 星型觸發

GA0、GA1、GA2 地理定址插腳
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其他資訊

軟體驅動程式

適用於 IVI-COM 驅動程式和 MATLAB DAQ Adaptor 的軟體元件
和應用程式在 Agilent USB 模組式產品和系統產品參考 DVD-ROM
中提供。

IVI-COM 驅動程式可用來設計 IVI-COM 環境中的測試儀器，
MATLAB DAQ Adaptor 則允許在 MathWorks 環境中控制資料擷
取模組式產品 (U2300A 系列、U2500A 系列和 U2600A 系列 )。

安裝 IVI-COM 驅動程式

在 Agilent Modular Products Installation Menu 上選取 Software
Driver > IVI-COM，然後選取要安裝之各產品系列的核取方塊。清除
要省略之各產品系列的核取方塊。

圖 5 Agilent IVI-COM Driver Installation Menu

附註 • IVI 共用元件同樣必須在安裝 IVI-COM 驅動程式之前安裝。在下列
IVI 網站中尋找 IVI 共用元件：www.ivifoundation.org 。

• 如有需要，也可以從下列網站下載 IVI-COM 驅動程式：
www.agilent.com/find/ivi-com 。
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安裝 MATLAB DAQ Adaptor

在 Agilent Modular Products Installation Menu 上選取 Software
Driver > MATLAB，然後選取要安裝之各產品系列的核取方塊。清除
要省略之各產品系列的核取方塊。

圖 6 Agilent MATLAB DAQ Adaptor Installation Menu

附註 為搭配 MATLAB 使用這些裝置，您需要安裝 MATLAB 和 Agilent 軟體
元件與應用程式，連接 DAQ 模組式產品，並且安裝各自所屬驅動程
式。以下提供 MATLAB 範例： 

• www.agilent.com/find/matlab_u2300a 適用 U2300A 系列 DAQ
• www.agilent.com/find/matlab_u2500a 適用 U2500A 系列 DAQ
• www.agilent.com/find/matlab_u2600a 適用 U2600A 系列 DIO

• 如需如何安裝 MATLAB DAQ Adaptor 的詳細資訊，請參閱各產品
系列的 Using the USB Multifunction Data Acquisition Devices with
MATLAB Software Quick Start Guides。

• 您可以直接從 MATLAB 安裝 DVD-ROM 或是從 MathWorks 網站安
裝 MATLAB 軟體。如果您還沒有 MATLAB 或 MATLAB 的 Data
Acquisition Toolbox 軟體，可以從下列位置取得試版：
www.mathworks.com/agilent/daq/tryit.html
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範例程式碼

提供 Agilent VEE、LabVIEW 和 Microsoft (C#、C++、VB7 和 VB6)
軟體平台的範例程式碼，以便協助您開始使用模組式產品。

檢視範例程式碼

在 Agilent Modular Products Installation Menu 上選取 Sample
Codes，然後選擇偏好的程式設計語言類型，如下圖所示。

圖 7 檢視範例程式碼

命令記錄器和轉碼器

Measurement Manager 提供您快速且簡單的設定和控制方式，而
不需要進行程式設計。若要進一步簡化工作，您可以使用所提供的
Command Logger 功能來記錄設定命令，並輕鬆地將其轉換成
Agilent VEE、Microsoft Visual Basic、Microsoft Visual C# 或
Microsoft Visual C++ 程式碼的程式碼片段。

• 若要啟動 Command Logger 功能，請啟動 Measurement Manager
並移至 Tools > Command Logger...。
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• 若要將記錄的指令轉換為其他語言：在指令記錄器視窗中，按一
下 File > Convert Command File。
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啟用您的裝置授權

如果您已購買附有選購產品的 USB 模組式產品，則必須啟動裝置
授權，才能使用其附加功能。您可以透過 Measurement Manager 中
的 Software Licensing 應用程式啟動裝置授權。

圖 8 軟體授權應用程式

• 若要啟動裝置授權，請啟動 Measurement Manager 並移至 Tools >
License Panel。

附註 如需如何使用 Command Logger 應用程式的詳細資訊，請參閱 Agilent
Measurement Manager Help File。

附註 • 如果您未購買附有選購產品的 USB 模組式產品，則不需執行此程
序。請參閱您的模組式產品的相應使用者指南，瞭解有關您的模
組式產品提供的選項的更多資訊。

• 如果您不希望安裝 Agilent Measurement Manager，則需要啟動
Software Licensing 獨立安裝程式。在 Agilent Modular Products
Installation Menu 上選取 Software Licensing，然後依照畫面上的
指示進行。
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• 若要驗證裝置授權，請從 Software Licensing 視窗中按一下 Verify
License > Update License。

附註 您將需要有效的裝置授權金鑰 (*.lic)。如果您沒有裝置授權金鑰，則
須至 www.agilent.com/find/softwarelicense 取得您的裝置授權金鑰。
請依照畫面上的指示，為您的裝置取得有效的授權金鑰。

附註 如需如何使用 Software Licensing 應用程式的詳細資訊，請參閱
Agilent Measurement Manager Help File。
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本頁預留空白。
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